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GeneMarker v2.9.0 Manual

Guiding Principles and Scope

This method contains the steps for the analysis of PowerPlex Fusion and Yfiler STR runs from
the 3130 using GeneMarker HID v2.9.0.

For more information on the use of GeneMarker HID v2.9.0 see Genéral Overview Section 19.

For first time GeneMarker use, for a new installation, or for new computenhardware see QC355-
GeneMarker setup.

This manual cannot cover all situations that could arise during the analysis of an STR run. If an
analyst encounters something that isn’t covered by this manual, they should seek their supervisor
for further guidance.

Load Data

To start your project, go to File — Qpen Data ~> Add

2.1.1 Navigate to the network felder containing the data files (i.e. the .fsa files) to be analyzed.

2.1.2 Select files to add (inelude only one ladder per project)

2.13 Hold Ctrl keystorselect multipleffiles

2.1.4 If analyzing all files;hold Ctrl and A keys

2.1.5 Select Open

2.1.6 Ensure correctfiles are added to list

2.1.7 Ensure Auto-Elevate is not selected.

2.1.8 Select OK

Ensure that prefixes LD, PC and NC are labeling the allelic ladder, positive control and
negative control, respectively, in the Sample File Tree.

2.2.1 If they are not, right click on the sample name in the Sample File Tree — Set Sample Type
— Select appropriate sample type

222 Click Run Project located in the top toolbar.
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3  Run Wizard
3.1 In Template Selection window, select the appropriate existing template; Fusion (Evidence),

Fusion Exemplars, or Yfiler® (Evidence or Exemplars). If “Last Template” is displayed in
Template Name field, ensure that the appropriate Panel is listed for your analysis.

3.1.1 Note: Do NOT click Save on any of the following windows. This will overwrite the
template for all analysts.

3.2 Fusion (Evidence)

Template Mame: |Fusi|:|n

Panel: |Fusion_OCME_no fiter - | [ | 2
Size Standard; |IL55I:IIII j% l

Standard Color. | DR&NGE - |

3.2.1 Click Next

322 In the Data Process window, ensure the following settings are used:
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Run Wizard @1

Data Process - HID Analysis
Set data process options

— Raw Data Analysiz
¥ Auto Range [frame]

Skart; ID j

End: [10000 ]
[+ Smoath [~ Enhanced Smo
Bazeline Subtraction:

[+ Superior [~ Classic

[~ Pullup Corection W Spike Removal

[~ Enhanced

¥ Saturation Detection [~ Saturation Repair

r— Allele Call

[~ Auto Range (bps]

Start; |55
ath

Percentage » |0

Maote: Use Pa

and % Glohal

Size Call

% Local Sauthern " Cubic Spline

Peak Detection Threshald: _"’I

tin Intensity: IED 3,

=

End: |51u
¥ Sca

& save | Delets [ Hewt>y | Cancel
323 Click Next
324 In the Additional Se ensure the following settings are used:

Run Wizard E
Additio 5 - HID Analysis
mted b ifferent analysis type
LI v Auto Select Best Ladder
LI v Auto Panel Adjustment
Reject < 000 Check [100  <Pass

T Misture Evaluation

Walid Misture Peak Percentage: ID %

Iir Miture tarker Humber: |3

& save | Delete << Back LCancel
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33 Fusion Exemplars
Template Mame: IFusiun Exemplars
Panel: |Fusion_OCME_10% - |_| ﬁ'
Size Standard: |ILS500 - |_|_[|_[|
Standard Color: | ORANGE |
3.3.1 Click Next
332 In the Data Process window, ensure the following setting
Run Wizard E-‘
Data Process - HID Analysis
Set data process options
— Raw Data Analysis Al
v Auta Range (frame) [~ Auto Range (bps]
Start [0 2] Stat [55 3 End [510 3]
¥ Smooth v Scare Filker
Baseline Subtraction: Peak Detection Threshold: _"I
in [ntensity: IED 3, I 3 | mtenzity: |32?ED 3,
Percentage » I'ID 3. Glabal tax
Mote: Use Panel Editor to set Min Intensity
and % Global Max for peaks within Markers
<< Back T Hent sy Cancel
333 Click Next
334 In the Additional Settings window, ensure the following settings are used:
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Run Wizard E

Additional Settings - HID Analysis

Set additional optionz related to the different analyzis type

Aleliz Ladder  [NONE = [v Auta Select Best Ladder

Positive Contial Template: IPP_Fusion j V¥ Auto Panel Adjustment
aillele Evaluatiorn

Peak Score:
Reject < ID.DD Check. |1.UU < Pazs

1 Misture Evaluation

Walid Misture Peak Percentage: IEI b4
Mir Misture M arker Mumber: |3

& save | Delete | << Back

34 Yfiler® (Evidence or Exemplars)

Template Mame: I"I"Filer

Panel: I\fﬁler_DCME =

Size Standard: ILIE_‘\"ﬁIer -

Standard Calor: IEIH

3.4.1 Xt
342 Int a Process window, ensure the following settings are used:
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Run Wizard @1

Data Process - HID Analysis
Set data process optiong

Fiaw Data Analyzis Allele Call
[ Auto Range [frame] [ Auto Range [bpsl

Stat [2300 3] End [3000 3] stat [75 3] End [0 _3
v Srnoath [ Enhanced Smoath ¥ Scére Filer
Baseline Subtraction: Peak Detection Thieshald: 7 |
[ Superior [ Clazzic | Enhanced Wi [ntenzity: ﬂ hdax [nkenzity: im
W Pull-up Corection  [w Spike Removal Percentage > m Global b&x

v Saturation Detection [~ Saturation Fepair MNote: Use Panel Editar taet in Integsity

and % Globaltbex for peaks withinharkers

Size Calt
(¢ Local Southem " Cubic Spline
& 5ave | Cancel
343 Click Next
344 In the Additional Settings window, ensure the following settings are used:

RunWizerd . . 4 =

Additional Settings - HID Analysis

Set additional optiohs related to the different analysis type

| . iHOHE J [V Auto Select Best Ladder

Pagitive,Contral Template: |Yﬁler MPC ﬂ W Auto Panel Adiustment
FAllele Evaluation

| Peak Score:

Reject < |0.00 Check [1.00 < Pass

[~ Mixture Evaluation

¢ Back | Ok | LCancel |

3.5 If NONE is listed under Positive control template, select the Positive Control Template using the
dropdown:
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3.6 For PowerPlex Fusion® (all templates) - PP_Fusion
3.7 For Yfiler® - Yfiler MPC
3.8 Note: Do NOT click Save within the Data Process Window. This will overwrite the template for
all analysts.
3.9 Click OK — Once data has finished processing Click OK
3.10  On the top left corner of the screen, Click File — Click Save Project— Navigate to desired

4

4.1

4.2

43

folder and save project using the naming system based on the instrumenty date, injection
number(s), kit and analysis set (i.e. Newton090615 8-11U A)

3.10.1  You must save over the existing project every timg\you save.

Checking the Size Standard

[

Located on the top toolbar in the main analysis window, Click Size Calibration

In the Calibration Charts window, Click Chart Synchronize ~—

Click Sample Name headerdo sort samples,in order. In the Sample List, either Click on a
Sample or Navigate using the Up/Down Arrows, check the size standard for each sample and
control as per the amplification kit.

4.3.1 PowerPlexdFusion®

200
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4.3.2 Yfiler ®
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433 If the peak is recognized by the software, a green inverted triangle appears at the top of the

peak. '

4.3.4 If a sample contains a size standard peak without a green triangle present the size standard
for that sample fails. Refer to STR Results Interpretation-PowerPlex Fusion & STRmixTM
manual.

4.4 Close Calibration Charts window.

4.4.1 If any sample or control is automatically marked as disabled by the software, review the
size standard in the Calibration Charts window to ensurefthis was due,to failing or poor size
standard. If it is confirmed that the sample has a failing or poof size standard, a rerun code
must be applied to that sample. Right click on thesample in'SampleyFile Tree within Main

Analysis Window = Click Edit Comments - Enter rerun codé¢ in Comments field >
Click OK

4.4.2 In the Main Analysis window, Click on the,Down Artow next to the Show Color icon
located in the top toolbar. — Click Hide All

443 In the Sample File Tree, RightiClick on Allele Call —Click Select Max

4.4.4 In the Main Analysis #vindow, Click on the Down Arrow next to the Show Color icon
located in the top toolbar. — Click ORANGE

44.5 Note: The siz¢'standard ¢an also be viewed in the Browse by All Color Window
4.5 Adjust axis to view sizefstandard depending on amplification kit

Y,

4.5.1 Onthe‘top,toolbar, Click Set Axis icon
452 Click Fixed ‘X > — enter X axis range

) PowerPlex Fusion® = 55-510
) Yfiler® = 75-410

453 Click Set Axis again — Select Auto Fit Y
4.6 Review size fragments by ensuring that all required peaks are labeled within +/- 0.5bp of the

fragment size. See the Fusion Ladder, PE and SS appendix or for Yfiler, the References - Allelic
Ladders, Controls, and Size Standards documents.

4.6.1 If a peak is not labeled or not within +/-0.5bp, then the size standard fails. Refer to STR
Results Interpretation-PowerPlex Fusion & STRmixTM manual.
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4.7 If any sample with failing or poor size standard has peaks called, the peak labels of those peaks
will need to be deleted.

4.7.1 Open the Browse by All Color analysis window > navigate to the relevant sample(s) =
highlight all peaks in one dye by holding down Ctrl, left click and dragging around any
peaks present in that dye - click Delete to remove the peak labels—> repeat for each dye

4.8 For any sample with failing or poor size standard, right click on sample ingSample File Tree
within Main Analysis Window > Click Edit Comments—> Enter rerun€ode in Comments
field=>Click OK

5 Checking the Allelic Ladder

5.1 There are two areas in the Main Analysis window that indicateyif the allelic ladder used for
analysis has passed.

5.1.1 In the Sample File Tree, a red question.markniext to the allelic ladder would indicate a
potentially failed ladder.

5.1.2 In the Project Summary, a ladder error'would indicate a potential failed ladder.

5.2 Right click in the Sample File Tree = €lick Select Max. Open the Browse by All Color Window
=3

icon &= Visually confirmall expected alleles in the allelic ladder are present. Refer to the
Fusion Ladder, PE and SS appendix orfor Yfiler, the References - Allelic Ladders, Controls, and
Size Standards documents.

53 If the ladder used for analysis failed, try another ladder present on the same analysis set if one is
available. Click File fromithe.menu bar = Click Open Data - Highlight the failed ladder from
the Data File List 2¢Click Remove - Click Add... = Navigate to the .fsa files > Select a
different ladder for analysis 2 Click Open - Click OK. Return to Load Data, Section 2.2 and
proceed.

5.4 If there are'no other passing allelic ladders in the analysis set refer to Refer to STR Results
Interpretation=PowerPlex Fusion & STRmixTM manual.

6  Amplification positive control (Fusion/YFiler)
6.1 For any STR plate, there must be at least one amplification positive control present.

6.2 The amplification positive control may be run at a different dilution than the corresponding
samples and the amplification set can pass.

6.3 A positive control may be edited for amplification or electrophoresis artifacts including (but not
limited to) pull-up, stutter and elevated baseline.
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6.4 Visually confirm all the expected alleles in the positive control according to the amplification kit

used. Refer to the Fusion Ladder, PE and SS appendix or for Yfiler, the References - Allelic
Ladders, Controls, and Size Standards documents..

6.4.1 A positive control that does not generate a complete genotype or gives an incorrect
genotype will be indicated as failing. Refer to STR Results Interpretation-PowerPlex
Fusion & STRmixTM manual for re-testing strategies

7  Negative Controls (Fusion/YFiler)

7.1 Evaluate the extraction and/or amplification negative control for'expectediresults: If peaks
attributed to DNA are detected refer to STR Results Interpretation-PowerPlex Fusion &
STRmixTM manual.

7.2 Some artifacts can be edited in a negative control if they are by-preducts of the

STR/amplification process. These include artifacts such as dye blobs, spikes, and primer front.
Only re-test if artifacts are so abundant that amplifiediDNA ‘might be masked.

73 If a negative control with no peaks present ¢ontaingymisshapen size standard peaks that are
correctly called, the control passes.

8 Analyzing Samples

8.1 Analysis of the data can be/performed in the Main Analysis window and/or the Browse by All
Color EZ window.

8.2 Adjust axis to view samples depending on amplification kit
P
8.2.1 On the top teolbar, Click Set Axis icon %
822 Click Fixed ‘X > = enter X axis range

e | PowerPlex Fusion® = 60-510
e Xfiler® = 90-340

8.2.3 Click Set Axis again — Select Auto Fit Y
9 Editing a peak
9.1 If a labeled peak is determined to be an artifact, click on the Peak to Highlight — Right Click—

Click Edit Comments— Enter code ‘a’ for artifact (refer to the editing codes document) — Click
OK.
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9.1.1 To select multiple peaks for editing, Hold the Ctrl key + left mouse click — Drag the
mouse to highlight all consecutive peaks

9.2 Once the Edit is selected, highlight the peak and press Delete key to remove the label from the
peak.

9.2.1 Note: If a label has been removed from a peak and needs to be restored, Click on Peak to
Highlight — Right Click —Undelete. If an edit needs to be remoyedsfrom a peak = right
click on peak = click edit comments = remove text from Comments: box'so the text field
is blank = Click OK (the E will still be visible but the edit comment will be removed)

9.3 To check peak history = Right click on peak = Click view history

9.3.1 Any changes made to the peak will be listed in order fromdnost recent down. Click on any
line to view specific change details in the Current/Qld Values: window. Scroll all the way
to the right to view edit code applied to peak in Allele Comments column.

9.4 +/- one repeat stutter should not be manually edited from'evidence in Fusion. Stutter can be
edited from Fusion positive control samplés,and exemplar samples.

9.5 Note: Peaks will only be considered stutter by the software if they are within the bin of the
stutter peak. If a peak is outside of the'stutter bin ofithe parent peak the software will not
automatically filter this out asstuitter, even if is under the stutter filter percentage for that location.

10 Over- Saturation
10.1 Check for saturatien detection

10.1.1  In the Maim*Analysis Window electropherogram a pink line will indicate the possible
saturation of peak. This indication will also be noted in the Peak Table as <SAT> for that
alleleyin the Allele,Comment field.

10.1.2  If aneyidence sample has excessively saturated peaks (>10,000 RFU or split peaks) this
sample must be rerun at a dilution. All peak labels must be removed. Enter the appropriate
re-run'code and dilution factor.

10.1.3  If an evidence sample has labeled peaks above 7,000 RFU, with minimal artifacts, editing
may be performed. If there are many instances of pull-up, pull-down, and/or elevated
baseline, the sample may be rerun at a dilution. All peak labels must be removed. Enter the
appropriate re-run code and dilution factor.

10.1.4  Exemplars or positive controls with saturated peaks may be interpreted if artifacts are easily
recognizable and can be edited. With the exception of Fusion Direct samples, exemplars
may be rerun at a dilution if needed.
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11 Scheduling Re-Runs

11.1  If a sample Failed (over saturation, bad size standard, no data, instrument issue, etc.) > Right
click on sample in Sample Tree within Main Analysis Window = Click Edit Comments -
Type Re-Run Code in the comment box = Click OK

11.1.1  Re-run codes cover the majority of, but not all, situations. If one does not exist which
specifically describes the issue, please enter a reason in LIMS as tofwhyithe sample failed
under the sample status column — ex. possible injection issue.

11.2  All peak labels must be removed from failed samples.

11.2.1  Open the Browse by All Color analysis window - nawvigate£o the relevant sample(s) >
highlight all peaks in one dye by holding down Cfrl, left elick and dragging around any
peaks present in that dye = click Delete to remove the peakilabéls—> repeat for each dye.

11.3  If sample did not fail but re-run is desired = Right'cliek on'sample in Sample Tree within Main
Analysis Window > Click Edit Comments 2 Type Re-Run Code in the comment box = Click
OK

12 Exporting for LIMS (all systems and sample types)

12.1  Once the entire run has beendeviewed, all edits have been made and labels have been removed
from all edited peaks, on the top left corner of the screen, Click File — Click Save Project

12.2  You must save over thesexisting project every time you save.

12.3  In the Main Analysis Window —> Click the down arrow next to the Show All Color icon = Click
Show All to turn‘on all colors before exporting.

12.4  In the reportidisplay section of the main analysis screen, click on the down arrow next to the Save

Report icon £ " “Ensure the “Save LIMS report” is selected.
12.5  In the LIMS report settings window that pops up, ensure the settings are as follows:
12.5.1  The Size Range will be the same as the X- axis range for analysis

e 90-340 for Yfiler
e 60-510 for Fusion/Fusion Exemplars

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology
Qualtrax software. All printed versions are non-controlled copies.
© NYC OFFICE OF CHIEF MEDICAL EXAMINER Qualtrax template 072220


http://qualtrax.csc.nycnet/Default.aspx?ID=1123

FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

GeneMarker Manual
Document ID: 6311

Status: Published
DATE EFFECTIVE APPROVED BY PAGE
10/29/2020 Nuclear DNA Technical Leader 13 OF 38
LIMS Report Settings @
Dyes Optiong

[v BLUE [ RED Iv Size Range(bps)

GCrEE . From |50 to {510

W TYELLOMW,

[~ Abide By Panel

[ Grouped By Markers
[ Show File Mame

Columns... |
[~ Show Sample Mame
W Show Deleted Peaks m [«
| Hide Extra Sample Mames [ Show Only Uncertain Alleles
[~ Exclude Report Header | Show Rejected Low Score Alleles

Ok Cahcel |

12.5.2 In Options, click on “Columns...”;use the: Add/Remove buttons to ensure the Selected
Columns are present and listed in the order that follows:

Selected Columnz

Plate 1D

b arker

Dye

Size

allele

Allele Comments
Sample Comments

Note: This isterucial to proper LIMS importation.

12.5.3  Click OK; Click OK again in the Allele Report Settings window.

12.6  Save the file as type “Excel File (*.xIsx;*.xls)” under the appropriate run name (delete suffix
“ AlleleReport”).

12.7  Navigate to the data entry screen for the corresponding test batch in LIMS. Click Import
Instrument Data and import the excel file for the project.

12.8  Fill out the data entry screen keeping in mind the following definitions:

12.8.1  Loaded — the data from GeneMarker has been imported
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12.8.2  Not loaded —the sample or control was not imported/loaded into GeneMarker
12.8.3  Pass — the control has passed

12.8.4  Fail — the control has not passed

12.8.5  No Data — the control has not been analyzed

12.8.6  Not Used — the control was not used in analysis of the STR run,fypicallyreserved for
additional allelic ladders

12.9  If a control needs to be rerun, a comment (reason as to why thé sample failed) and resolution
must be entered into the LIMS data entry screen.

13 Printing Initial Analysis Electropherograms (all system and sample types)

Note: If exporting a PDF of an electropherogram from a'run that was analyzed in GeneMarker v
2.8.2, please refer to section 18.

13.1  Inthe Sample File Tree > right click = select, Max.
13.1.1  Double-click to DESELECT thexailed samples that are scheduled for rerun due to “no or
poor size standard”. The®pdf of electropherogram is not necessary since the sample status

is indicated on the rerun table.

13.1.2  Include all samples that failed for reasons other than “no or poor size standard.” The .pdfs
of the electropherograms withsall peak labels removed must be included within the casefile.

13.2  Click View—> Preferences =>10thers tab
13.2.1 Ensute box for“Enable Sample Grouping” is checked = Click OK

13.3  In Main Analysis Window click Project > Apply Sample Grouping (if grayed out return to step
13.1)

13.3.1  Click Group By Order on the bottom left
13.3.2  Change Group Size to 1
13.3.3  Click Match on the bottom right = Click OK

13.4  In the main analysis window = Click Set Axis = Click Fixed X axis. The Size Range will be
the same as the X- axis range for analysis:
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e 60-510 for Fusion
e 90-340 for Yfiler

13.5  Click Set Axis again — Select Auto Fit Y &
13.6  In Main Analysis window = Click Print Icon
13.6.1

13.6.1.1 Standard Tab:

Pant Report

. Standard
& Select an Exizting Template or Create One andar IAdvancedI Page I

Template Name: IDCME Prirt Template Frint Type
¢ Mommal
E}OCME Print Template

= Chart Overlay

Sample

Select OCME Print Template on left and ensure the settings match

Al Samples

Mix Dyes

v Hide Bins

" Use Last Template

bl 2ave | x Delete |

S |

LCancel
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13.6.1.2 Advanced Tab:

Print Report

™ Usze Last Template

. I Ad d
+ Select an Existing Template or Create One Standard ance | Page I

Template Mame: IDCME Frint Template Header:
[~ Print Project Comments [~ Each Paos [ WWord Wiap
EJOCME Print Template

[+ Print Report Headsr ¥ Each Page

[~ Label Dyes & Peak Mumbers W File Name [~ Sampls Nam
Marker: Allele:

W Print Markers
[~ Ahide by Panel

W Print Alleles

W Auto Scals Markers
Other:

I~ Grouped by Dye
v Mew Page for Each Sample

v Implement % Axis Setings

W Frint Samples Wwith Gro

13.6.1.3 Page Tab

Print Report

{* Select an Existing Template or Creat

Template MName:

OCME Priry

EYOCME Print Templ:

7 Use Last Template

" Standard | Ad age
— Paper
Size Type: ILetter LI
“width [mm): |21 59 Height (rmm): |2?9.4
— Margin [mm) Orientation
Left: [120 Right: [12.0 & Portrait
Top: |13.D Bottom: |13-U " Landscape

& Save | X Delete | =113 | Cancel |

13.6.2

Click Preview = Click Export to File icon ® Assure settings match below:
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Export Report to Files @
Export Farmat: | POF file j

File Maming tethod
(o Mamed by sample name
[~ Start by Page Mumber
" Mamed by file name
o

" Mamed by page number

W Save Group Samples as One File

13.6.3  Click on the “...” icon to choose the appropriate export directoty for the PDF files
13.6.4  Click OK - Export Report to PDFs Events window,will appear. Once completed click OK

13.7  If analyzing Fusion Evidence: Wait to import,PDFs into LIMS until after the completion of
STRmix analysis, section 1_5

13.8  If analyzing Exemplars or Yfiler Evidence: Import all PDFs into LIMS.

14 Fusion Exemplars Only - Exporting EXEMPLAR table for STRmixTM
input (for evidencetablejiinstriictions see Section 0)

14.1  In Main Analysis'Window Click the ﬂ " icon > Select Show AlL In the report display section

L
of the main-analysis screen, click on the report settings icon . Make sure settings match
below:
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Allele Report Settings
~Report Style 1 Options
" Allele List |v Extend Diploid Homozygous
@ Forensics ™ Splt ltems
" Bin Table v Show Allele Name
" Peak Table v Show Size (0.1bps)
" Allele Count v Show Height
) | [ Show Area
v Show File Name [~ Show Score

14.2 tion of the main analysis screen, click on the down arrow
. Ensure the “Save Report™ is selected.

14.3 older and save file as an excel file (*.xlsx;*.xIs)’named as “Run

14.4 Rmix™ import the GeneMarker® to STRmix™ macro needs to be run.

14.4.1  Open the exported project excel file from Step 14.3 above.

14.42  Open GeneMarker® to STRmix™ macro.

14.4.3 Follow the instructions on the “instructions” tab.

14.5  After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.

14.6  Change the file type to “.txt” (text, tab delimited)
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14.7  Navigate to folder containing your project data and save file there.

15 Fusion Evidence Only - STRmix™ Analysis (stutter filters off)

15.1  Begin by importing the data from the initial analysis into LIMS to generate the edit sheet. Have

the edit sheet open in LIMS as you perform the second analysis with stutter filters off for
STRmix™ to refer to and ensure the same edits are being made the second time.

15.1.1  If Project is still open = Click Run Project —_ located in th€ top toolbar.

15.1.2  Ifproject is not open = Click File = Open Project > Navigate totun —>¢select project >

click open > Click Run Project —— located in the fop,toolbar.

15.2  In Template Selection window, select the appropriate existing template.

Run Wizard

o \
Template Selection

Set the template of the project

& Select an existing template or create one

A Fusion TemplateNaie: [Fusion_STRmix

gusors Panet IFusion_OCME_FFRmix_NDI - L] =

A YFiler Size Standard mw
Standard Colof IDF\ANGE -

™ Use last template

= Save | A Delete | Hext > | LCancel

15.3  Click Next
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15.4  Inthe Data Process window, ensure the following settings are used:
Run Wizard @
Data Process - HID Analysis
Set data process oplions
Raw D ata Analysiz Allele Call
[v Auto Range [frame) [~ Auto Range (bps) |
o3 10000 3] Stat [55 2] End [510 3 |
[v Smooth [~ Enhanced Smoath ¥ Scordilter
Bazeline Subtraction: Peak Detection Threshold: j
Iv Superior [~ Clazsic [ Enhanced Min Intengity: |50 | ddaw Intensity: | 32760 ':] I
[ Pullup Corection  [w Spike Femoval Percentage » |0 vl Global b ax I
¥ Saturation Detection [ Saturation Repair Mote: Use Panél Editartgsét Min Intensitd
) and % Global Maxfor peakswithin hgrkers
Size Call
f* Local Southern ™ Cubic Spline
& Save | << Back Cancel
15.5  Click Next
15.6  In the Additional Settings window, ensure the following settings are used:
Run Wizard ‘ ’ @
| Additional Settings - HID Analysis
Set additional options related ta the different analyzis type
G NenE J v Auto Select Best Ladder
Positive Contral Template: |PP_Fusi0n j W Auto Panel Adiustment
| |—Allele E waluation
Peak Score:
Reject ¢ |0.00 Check (1.00 < Pazz
[~ Mixture Evaluation
0
3
& Save | | << Back Cancel |
15.6.1  Note: Do NOT click Save within the Data Process Window. This will overwrite the

template for all analysts.
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15.7  Click OK - A window will pop up:

Use Old Calibration =

& Size Calibration

The internal lane sizes hawe been calibrated in the samples.
“'ou may check Call Size Again to recall the sizes.

What to do:

Apply bo Al | Apply to Current

15.7.1  Check “Call size again” and Click Apply.to All=>, Allow data to process = Click OK

15.8  On the top left corner of the screen, Click File = ‘Click Save Project = Save Project with suffix
_SM

15.9  Perform a second analysis of this run

15.9.1 Do not recheck or edit Ladder, Size Standard or Controls. Passing controls and size
standard are determined by the initial analysis. Leave all controls and failed samples
ENABLED

15.9.2  Remove the labels from the same peaks that were edited in the initial analysis. It is not
necessary toenter edit codes again.

15.9.2.1 (If'amartifact (exeluding stutter) was previously filtered out in the original analysis (ex. a
pull-up-that.was adjacent to a stutter bin) but is present in the STRmix analysis, the label
mustdbe removed from this analysis set. This edit must be recorded directly into the LIMS
data entry screen.

15.9.3  If a sample had a rerun code during the initial analysis it is NOT necessary to enter the
rerun code again.

15.10 Once the entire run has been reviewed, and labels have been removed from all artifact peaks,
Click File — Click Save Project
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16 Fusion Evidence Only - Printing Electropherograms after STRmix™
Analysis (evidence samples only)

Note: If printing or exporting a PDF of an electropherogram from a run that was analyzed in
GeneMarker v 2.8.2, please refer to section 18

16.1  In Sample File Tree - right click 2 Select Max

16.2  Double click on sample to DESELECT:

e All Controls (Ladder, PC, NC, Eneg, Mneg)
¢ Any failed sample

16.3  Click View=> Preferences = Others tab

16.4  Ensure the box for “Enable Sample Grouping” igschecked 2 Click OK

16.5  In Main Analysis Window click Project = Apply. Sample Grouping (if grayed out return to step

16.1)

16.6  Click Group By Order on the bottormleft

16.7  Change Group Size to 1

16.8  Click Match on the bottom right > Click OK

16.9  In the main analysis window > €lick Set Axis = Click Fixed X axis The Size Range will be
the same as thedX- axis range for analysis:

e 60-510%or Fusion

16.10 Click Set Axis again.— Select Auto Fit Y

16.11 In Main Analysis window = Click Print Icon

16.12 Select OCME Print Template on left

16.13  Ensure the settings match below:
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16.13.1 Standard Tab:
%

. Standard
i+ Select an Existing Template or Create One andar IAdvancedI Page I

Template Mame: IDCME Prirnt Template Pririt Type
* Mommal
EJOCME Print Template

= Chart Overlay

Sample

Al Samples

{* Selected Samples

Dye
v BLUE ¥ RED
[V GREEN [~ ORA
WV YELLOW

Content

¥ Electopheragram

PeakT able
& Follow Trace Chart

€ Start on Separate Page

€ Start after &1l Charts Finished

[™ Forenzics Table

 Use Last Template

LCancel

16.13.2 Advanced Tab:

" Print Report

ENOCME Print Temp 1te

Standard
Header:
™ Fii

Frint Feport Header

roject Comments

[~ Label Dyes & Peak Mumbers
Marker:

v FPrint Markers

[~ ahide by Panel

W &t Scale Markers
Other:

I~ Grouped by Dye

¥ Mew Page for Each Sample

W Implement ' Axis Setings

€ Use Last Template [V Print § amples \With Grouping

I~ Each Page

I “word Wrap

¥ Each Page

W File Name [~ Sample Name
Allele:

v Frint Alleles
I Frint Edited Peak Orly
W Mark Deleted/E dited Peak.s

Label Peak Ratio
% Label Peak Height Fatic

" Label Feak drea Ratio

Chart Height (i [38 :I'

& Save | x Delete |

So |

LCancel |
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16.13.3 Page Tab

Print Report

* Select an Existing Template or Create One

Template Mame: IDCME Frint Template
EJOCME Print Template

" Standard | Advanced Page

16.17

 lse Last Template

— Paper

Size Type: I Letter

Wwidth [mm):  |215.9

— Margin [mm)
Left: [12.0 Right: [12.0
Top 130 Battom: [13.0

& save | X Delete |

16.14  Click Preview - Click Export to File icon ss

apoaneponwﬁg‘"'

Export Format: | POF fle
File Naming Method

W SaveG amples as One Fie

ettings match below:

16.15 Click on the “...” icon to choose the appropriate export directory for the PDF files
16.16 Click OK - Export Report to PDFs Events window will appear. Once completed click OK

Import all PDFs (initial Fusion analysis and STRmix analysis) at the same time into LIMS.
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17 Fusion Evidence Only - Exporting EVIDENCE table for STRmix™ input

17.1  In the report display section of the main analysis screen, click on the report settings icon .
Make sure settings match below:

Allele Report Settings @\
Report Siyle Options
" Allele List [v Estend Diploid Homozygous
(* Forensics I~ Bpltltems
" Bin Table [v Show Allele Mame
" Peak Table [v Show Size (0.1bps)
" Allele Count v Show Height
| Show Area
v Show File Name [ Show Score

Show Sample N
M) Sz A ™ Show [ When No Allee Caf

Orientation ™ Show Only Uncertain AlleicS
" Hotizontal & Vertical
[v Show Rejected LowwSeare Allsles
[~ Exclude Sample Index [~ Hide Extra Sample Names

[~ Exclude Report Header [~ Show Selegted Sample$

o | Cancel J

172  Click OK

17.3  In the report display'section of the main analysis screen, click on the arrow of the Save Report

icon T . Click “Save Report”

17.4  Navigateg.to appropriate folder and save file as “Excel File (*.xlsx;* xIs)” named as ‘“Run
name SM™

17.5  For proper, STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.

17.5.1  Open the exported project excel file from Step 17.4 above.

17.5.2  Open GeneMarker® to STRmixTM macro.

17.5.3  Follow the instructions on the “instructions” tab.
17.5.4  After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.

17.5.5  Change the file type to “.txt” (Text, tab delimited)
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17.5.6  Navigate to folder containing your project data and save file there.

18 Re-printing/exporting a PDF for a sample from a run that was analyzed

in GeneMarker v 2.8.2
18.1  In the main analysis window,
18.1.1  Click Set Axis = Click Fixed X axis
18.1.2  The Size Range will be the same as the X- axis range for analysis:

e 60-510 for Fusion
e 90-340 for Yfiler

18.1.3 Select Auto Fit Y

18.2  Click Tools=> Export Electropherogram

18.3  Set Output Folder to desired location for project PDEs by clicking ] icon

Export Electropherograms \I \ ' @

Output Falder: |h-1:"»5 TR_Datahla_[Ch\Aena 200 6'vathena03141 6_10-11_2016-03-14%

18.4  Ensure settings mateh'below:

18.4.1  Make sufe to select PDF as export format

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology

Qualtrax software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER

Qualtrax template 072220




FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

Status: Published

GeneMarker Manual

Document ID: 6311

DATE EFFECTIVE

APPROVED BY

PAGE

10/29/2020 Nuclear DNA Technical Leader 27 OF 38

Select Dyes

v BLUE

v| GREEN

v YELLOW

v RED
ORANGE

Dye Image Size

width | 1024 pizels
Height: |700 pixels

[~ Orneimage per sample

v Buto Scale Size Bange
[~ Auto Scale Marker Intengity

Ewport Format: |PDF file -

18.4.2  For exemplar or non-SM analysis: In'the suffix\field enter the run name with a “ ” before
it. (Ex: _Newton061316 88-89U A)

18.4.3  For SM analysis: In the suffix field enter the run name with a “ ” before it followed by
_SM (Ex: Newton061316 88-89U Ay, SM) to indicate STRmix™ analysis.

18.5  Printing the ladder: Right click in the sample list > click Deselect All 2 Check the box for the
ladder = In prefix field'enterladders. = click Export

18.6  Printing the controls: Uncheck the box for the ladder and check the box for all controls in the run
- In the prefix fieldé@nter controls_ - click Export

18.7  Printing the samples: Right click in the sample list = click Select All & Uncheck the box for all
ladders and controlsiin the run, leaving all samples selected = clear the prefix field = click

Export. This will create 4 PDFs for every sample, one for each dye.

18.8  Import all PDFs (initial Fusion analysis and STRmix analysis, as applicable) at the same time into
LIMS.

19 General Overview
19.1  Main Analysis Window
19.1.1  There are four major displays in the main analysis window.
1 Navigator; Sample File Tree
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2 Electropherograms
3 Report; Report Table
4 Project Summary

19.1.2 See HELPFUL ICONS INDEX for further details.

= r|FEES -9 8 ks = A B v v Make [
e 7 ;

D5-Alled | ader_§ HOY 045 fan (DE-Akedc Ladder 1) - AleirLadder

7 F 13-500pg PHAT_E02 040
B 1425000 DHAZ= FO2 0124

L2-E00pg DHAL

H B 1525000 DNAZs G0 0144
? B 16-150pg_DHAZn 02 016

L3-500pg Timzx|

7 - GLD: dralekic_Ladder 2 203

L4-220pg_DHAS cf

18-150p0_PrAZz_BOZ 003.f

L6-2E0pg_DHAl 3|

15-130pg_praach_co3_oosd

LE-ZE0pq DHASEH

H 20-150pg_DHAZ:_D0F 007
? 21-135p9_DHAZs_ED3 003 f

LB-1E0pg DAL

21-135pg DA FO3 D1LF

L3-150pg TRz

¢ - D-12n Drads_G03 010

20-120pg_Diad <]

24-100pg_DHAZs HIZ 0154

21-136pg_DWAZ |

25-100pg_DHAZS_M0d 0024
%6-100pg_DHAZ:_Doa_poa f i o

35 135pg_ DAzt
23-13 Spg_DHAI o

1 o K
E 27-TEpg_DNAZ T4 006,85 | i35 7|2 AR 151 111812
7 B @-Tag_owazh_ Do+ oon.f > P

24-100pg_ WA al

e 29-Tipg DWAZ: 54, 00, e

2 5-200pg_oHasz]

3 L 3+-30pg DNA_BOS D03.f

+ ol 30-50pg DNA_FO9 D111 3¢ |26-10Dpg CHAIc) 16
i ik 31-500g_DHAZL_ G0+ _014F5 26 |27-7Epg IWAZa | 1
7 =B 32300 pwaz o4 ol 3a |28
~7=pg_miazs_| 18
? 33 HA 2805 D0
sk a7 |23-76pg OWAZ: | 15

35-30pg_PKAZ: 15 o5 fo

20-50pg_oHAza |

B -257g DNAZ D05 0075 [ra2s

1R Dpa_LHAZE |

T-1ipg DNAZ_FO5_009.fs =50

32 -50pg THR2: |

1500 _DhAZDFOS 011

33-30pg_miaza |

M-150 DHAZA GOS_O13.f5

34-30pg_IHAZD |

[35-30pg_mHAGs)

[$6-25pg DT _|

#7-25pg THAZD_|

Rh-h Bhhh RE- DD ERERRE

20-22pg_mazc |

£3-15pg DHAZs

1 1 = A
By ey B [y By By By Oy By iy By iy g |y iy Oy Oy gy Oy By
L]

13- Gpg T2

34-7_npg_owaz:|

& |45-7.6pg CWadcf

257,300, 423 44 58 T, .0

45-3_3Epq_DEAS| o -

:anium:ﬁ\';Eswm- im 300325 —
20,1 |:g;z\emwm |22l z::|m 2% 357 37a. a00.{e0m 458 MTA 500.0 Fat
22 122430 24 mzs-ammmlmp‘ﬁmmzs&asa 290 265 260 37T Ex|

47-3_Ehpg DeRD| ae s

[ B BARRREARERRRARRARRARRARARBRRRER

=

PC snar: 0 MNC erroe: 070 Ladakat e 43| =Failed=7 | =Fagged=12
i —_ B =

19.2  Navigator;

19.2.1  This view lists all the samples that are included in the project. Prefixes LD,

labeling the allelic ladder, positive control and negative control

19.2.2  The sheet icon to the left of the sample name indicated the quality of the internal lane

standard (ILS) with the following color/code:

o Green = High Lane Quality; Passing Size Standard E

e Yellow = Requires Verification B
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e Red strike through = No Sizing Occurrence; failed to call size O
e Red Question Mark = one or more quality criteria are not met based on the

analysis parameters; See Quality Reasons Index for more details.

19.3  Project Summary

19.3.1  This bar located at the bottom of the main analysis screen summatizes the project as well as
alerts the analyst to samples that did not pass analysis parameters.

New 22 samples PCerror: 1/1 NC error: 3/3 |—La|:||:|er erron ;1 | V' #Failed=1 #Hagged=19

o New reflects the data set is not a project thatthas'been'previously analyzed.

e If the first column reads Modified, the project was previously analyzed in the
software.

o The second column denotes the number of samples (including controls) contained in
the data set.

e Columns 3-5 indicate theynumber of'controls in the data set that do not meet the
quality criteria setfin the software.

e Column 6 denotes the number of samples that were disabled.

e Column_Zdenotes the overall number of samples, except the allelic ladder, that do

not meet the|quality criteria set in the software.

19.3.2  Note: Flagging features are an indication of potential failures. The ultimate decision of
passing/failure is.made by the analyst after further evaluation.

19.4  Calibration\Chart Window
19.4.1  There'are three major displays in the calibration chart window.

1 Sample List
2 Size Standard Template
3 Sample ILS
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19.5  Sample List
19.5.1 iew li e samples that were processed in the project. The Score column

0 100, the better the match. The sample may fail automatically if the size standard
enough or may have to be failed manually by the analyst.

19.6  Size Standard Template

19.6.1  The template highlights all the peaks that should be labeled in the corresponding sample
ILS for easier comparison.

19.7  Samples ILS

19.7.1  The sample ILS displays the peaks that were detected. As well as the approximate start of
the data analysis view, indicated by the dash line.
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19.8  Browse by All Color Window

19.8.1  There are four features in the Browse by All Color that allow for straightforward review of
the sample.

1 Sample Drop-Down
2 Max Chart Number
3 Scroll Within a Sample
4 Scroll Between Samples
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19.9  Sample Drop-Down

19.9.1  The sample drop-down lists all the samples within a project. A user can move between
samples by clicking on the sample name instead of scrolling through all electropherograms.

7

19.9.2 NOTE: Analysts can zoom in/out by using the zoom icons e located at the top
toolbar. As an additional option, hold down the left button on the moeuse and drag the
dotted box that appears from the upper left to the lower right (azeund the'desired “zoom in”
area). To zoom out, hold down the left button on the mouse again dragging box from lower
right to upper left. To scroll while zoomed in, right click and hold while dragging the
mouse in the direction you want to scroll.

19.10 Max Chart Number

19.10.1 Max chart number views each sample by the number of dye‘lanes as per the user’s needs
during sample analysis.

19.11 Allele Labels

19.11.1 When analyzing samples in the Main Analysis window or the Browse by All Color
window, alleles may be coloredyyellow or red.

| THO1 | | @r3s317 || Gwessas | | D251338 |
160 180 200 280 240 (@E0 280 300 320 340 380

AN L g

T & ] 145

1750 2166 2651 31949

3316 G453 5106 5842
| 11 11 21
1524 225.5 2762 3323
pere = 7503 Ve 4 G007

19.11.2 This indicates that one or more quality criteria have not been met in the software. See
Quality Reasons Index for more details.

19.11.3 Note: Flagging features are an indication of potential artifacts and/or allelic imbalance, or
peak saturation. The ultimate decision of passing/failure is made by the analyst after further
evaluation.
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19.12 Peak Table

19.12.1 When analyzing samples in the Main Analysis window or the Browse by All Color
window, a peak table maybe added to supplement analysis by clicking Show Chart/Table

1con

= 1 —

| DES1179 | | D21511 | [ oiSezn | [0 csFiFo |
100 150 200 250 300 350

1,200
1,400
1,000

900
800 | |
700
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300
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mEﬁJL_uL WL Jull

=100 4

30,207 5,528

[11,274.9,456 [12,3293,702]
Mo, | Dype Sj t " Allele [Juality Score | Allele Comments [uality Rea...
1 Blue 95.7 176 957 Undeter.. 1.3 oL
2 Blue 1437 4153 LBs51179 13 Pass 121.7
3 Blue 2078 « 824 02151 an Pass 1006
4 Blue 2708 B21 L7s820 10 Pass 161
A Blue 274,97 456 L7s820 11 Pass 271
g Blue 3211 1154 CSF1PO 10 Pass 971
7 Blue 2283 F02 CSF1PO 12 Pass 465

19.12.2  This table will indicate to an analyst which alleles were flagged and which quality reason
was triggered. See PEAK TABLE OPTIONS INDEX for further details.
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20 HELPFUL ICONS INDEX
20.1  Main Toolbar Icons
Icon Name Function
Run Project | Opens Run Wizard for processing the data.
| 4
Show/Hide | Allows user to show/hide the frames for the Sample File Tree,
7 B W Toggles Synthetic Gel Image and Report Table, respectively.
Allows user the choice of viewing/hiding all color lanes or
B Show Color | single dye lane layer (with single left mouse click on the icon,
v obtain single dye view)
Allows for more discriminate view of electropherogram.
Zoom/Zo0o Alternately, hold down left mouse button and draw a box;
m Ot dragging from top left corner to bottom right zooms in on
\ @\ image while dragging from bottom right corner to top left
zooms out.
Default sets Y-axis by maximum peak intensity for the
\ Set Axis sample displayed. The other 2 options either auto-fit the Y-
% axis by the peak intensity of the alleles displayed, or allow for
setting the X- and Y- axes ranges manually.
Browse Allows for comparative view display of sample
by All electropherograms by dye color. Individual samples can be
g C)(I)lors selected from the drop down menu in the upper right corner
il of the All Color Browser display window.
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20.2  Allele Call Icons available after raw data processing only; Sample File Tree Allele Call folder must

be selected

Icon Name Function
| gl:leibra tion Displays calibration charts for linéarity,of lane analysis.

Allows user to toggle‘the display to show only the Peak Table,

Show

7= Chart/Table the Peak Table and the Eléctropherogram, or just the
Electropherogram.
. Allows user to export the Peak Table as an Excel(.xls) file or a
Save Peak Table | i climited Text (.txt) file.
Allows user to call alleles by sample(s), by marker or by dyes.
Allows,user to make some modifications to the threshold/filter
= Call Allele séttings without having to activate Run Wizard again (i.e. Peak
g g g

Detection Threshold, Stutter Peak Filter and Peak Score
Threshold).

Marker

Make Hore- v Drop- Allows user to select a marker to view. Available after the
€ down samples have been compared to a Panel.
Menu
Event Log Displays the processing success/failure of each dye lane.
a3l Magic Activates the Start Your Project, Run and/or Report dialog
- Wizard boxes.
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20.3  Browse By All Colors Icons
Icon | Name Function

G)\ e\ Zoom In/ Same use as in the Main Analysis Screen.
Zoom Out
Show/Hide Allows user the optionto,show/hide X- and Y- axis grid

Mouse Cross
Lines

lines that appear at the tip of the mouse cursor along with
the basepair size and RFU value of the mouse cursor
position.

A Show/Hide Allowsyuser the option to show/hide the Bin brackets at
- Bin Ranges the top and'bottom of the electropherogram.

Allows user the option to adjust the RFU intensities of

lﬁs Auto Scale low peaks to match the 1ntens1ty. of the hlghest'peak in the

Mafkers dye color. When low peaks are increased, the intensity

magnification factor is noted in the marker (can adjust
from 2X to 8X).

= Print Opens the Print Report settings box. Also accessible in the

Main Analysis screen.
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20.4  Report Table Icons located directly above the Report Table.

Icon | Name Description
Report Allows user to customize Report Table display
| — | Settings settings.
=] Save Allows user to export the Report Tdble as an Excel
_— Report (.xIs) file oritab-delimited Text (.txt) file.
Sustomlz Allows user to select which bins to include/exclude
Bin in the Report Table (check with TSL as this is
Column not accessible at this time)
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21 PEAK TABLE OPTIONS INDEX

Dye dye lane location of peak
Size peak basepair size (x-axis)
Height value given as relative frequency units (RFU) of the peak (y-axis)
Height peak height divided by height of highest peak in the dyedane, or
Ratio Marker
indicates the area under the curve of the peak; calculated based
Area . .
on x-axis Start/End column settings
Area peak area divided by area of highest peak inithe dye lane or
Ratio Marker
Marker locus location of the peak
bin location of the peak (based on kit/system paneband ladder
Allele . .
analysis of project)
. absolute value of distance between the peak center and Bin center
Difference | . .
in basepairs
assigns Pass/Check/Undetermined quality ranking for each peak
Quality relative to the Allele Evaluation'Peak Score settings in the Run
Wizard (see Additional Settings)
an exponential.curve based evaluation of the peak; calculation of
Score the value is based on signal-to-noise ratio and peak shape (or
morphology)
Start/End | beginning andfinish basepairs of the peak's Area calculation
Allele software and user edited comment.s for the peak; right mouse
Comments click peak in chart to add peak edit comments or select from the
drop:down list (more in Edit Comments Index)
user added comments for the sample; right mouse click sample
Samplé . .
Comments | ame in the sample tree to add new sample edit comments or
select'from the drop down list (more in Sample Comments Index)
Quality letter code abbreviation(s) of reason(s) for a peak 's Quality
Reasons assignment if ranked Check/Undetermined
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